WinCC Migration Guide (TIA Portal)

WinCC Basic, Comfort / Advanced, STEP 7 V5.x, WinCC flexible 2008 SP3 / SP5

Legal information

Use of application examples

Application examples illustrate the solution of automation tasks through an interaction of several components in the form of text, graphics and/or software modules. The application examples are a free service by Siemens AG and/or a subsidiary of Siemens AG ("Siemens"). They are non-binding and make no claim to completeness or functionality regarding configuration and equipment. The application examples merely offer help with typical tasks; they do not constitute customer-specific solutions. You yourself are responsible for the proper and safe operation of the products in accordance with applicable regulations and must also check the function of the respective application example and customize it for your system.

Siemens grants you the non-exclusive, non-sublicensable and non-transferable right to have the application examples used by technically trained personnel. Any change to the application examples is your responsibility. Sharing the application examples with third parties or copying the application examples or excerpts thereof is permitted only in combination with your own products. The application examples are not required to undergo the customary tests and quality inspections of a chargeable product; they may have functional and performance defects as well as errors. It is your responsibility to use them in such a manner that any malfunctions that may occur do not result in property damage or injury to persons.

Disclaimer of liability

Siemens shall not assume any liability, for any legal reason whatsoever, including, without limitation, liability for the usability, availability, completeness and freedom from defects of the application examples as well as for related information, configuration and performance data and any damage caused thereby. This shall not apply in cases of mandatory liability, for example under the German Product Liability Act, or in cases of intent, gross negligence, or culpa ble loss of life, bodily injury or damage to health, non-compliance with a guarantee, fraudulent non disclosure of a defect, or culpable breach of material contractual obligations. Claims for damages arising from a breach of material contractual obligations shall however be limited to the foreseeable damage typical of the type of agreement, unless liability arises from intent or gross negligence or is based on loss of life, bodily injury or damage to health. The foregoing provisions do not imply any change in the burden of proof to your detriment. You shall indemnify Siemens against existing or future claims of third parties in this connection except where Siemens is mandatorily liable.

By using the application examples you acknowledge that Siemens cannot be held liable for any damage beyond the liability provisions described.

Further Notes

Siemens reserves the right to make changes to the application examples at any time without notice. In case of discrepancies between the suggestions in the application examples and other Siemens publications such as catalogs, the content of the other documentation shall have precedence.

The Siemens terms of use (https://support.industry.siemens.com) shall also apply.

Security information

Siemens provides products and solutions with Industrial Security functions that support the secure operation of plants, systems, machines and networks.

To protect plants, systems, machines and networks against cyber threats, it is necessary to implement (and continuously maintain) a holistic, state-of-the-art Industrial Security concept. Products and solutions from Siemens are only one part of such a concept. It is the customer’s responsibility to prevent unauthorized access to the customer’s plants, systems, machines and networks. Systems, machines and components should only be connected with the company’s network or the Internet, when and insofar as this is required and the appropriate protective measures (for example, use of firewalls and network segmentation) have been taken.

In addition, Siemens’ recommendations regarding appropriate protective action should be followed. For additional information on industrial security measures that may be implemented, please visit https://www.siemens.com/industrialsecurity.

Siemens’ products and solutions undergo continuous development to make them even more secure. Siemens strongly recommends to carry out updates as soon as the respective updates are available and always only to use the current product versions. Use of product versions that are no longer supported, and failure to apply latest updates may increase customer’s exposure to cyber threats.

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed at: http://www.siemens.com/industrialsecurity.
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Task</td>
<td>5</td>
</tr>
<tr>
<td>1.1</td>
<td>Introduction</td>
<td>5</td>
</tr>
<tr>
<td>1.2</td>
<td>Overview of the initial situation</td>
<td>7</td>
</tr>
<tr>
<td>2</td>
<td>Basics</td>
<td>8</td>
</tr>
<tr>
<td>2.1</td>
<td>Information on the products</td>
<td>8</td>
</tr>
<tr>
<td>2.1.1</td>
<td>Software compatibility</td>
<td>8</td>
</tr>
<tr>
<td>2.1.2</td>
<td>Software and operating system requirements</td>
<td>8</td>
</tr>
<tr>
<td>2.2</td>
<td>WinCC (TIA Portal)</td>
<td>9</td>
</tr>
<tr>
<td>2.2.1</td>
<td>HMI software overview</td>
<td>9</td>
</tr>
<tr>
<td>2.2.2</td>
<td>STEP 7 Software overview</td>
<td>10</td>
</tr>
<tr>
<td>2.3</td>
<td>Migration requirements</td>
<td>11</td>
</tr>
<tr>
<td>2.3.1</td>
<td>Checking the hardware and software components used</td>
<td>11</td>
</tr>
<tr>
<td>2.3.2</td>
<td>WinCC flexible project</td>
<td>11</td>
</tr>
<tr>
<td>2.3.3</td>
<td>Non-supported operator panels under &quot;WinCC V15&quot;</td>
<td>12</td>
</tr>
<tr>
<td>2.3.4</td>
<td>STEP 7 V5.x project</td>
<td>12</td>
</tr>
<tr>
<td>2.4</td>
<td>Hardware/software is not supported</td>
<td>13</td>
</tr>
<tr>
<td>2.4.1</td>
<td>PLC modules used</td>
<td>13</td>
</tr>
<tr>
<td>2.4.2</td>
<td>Operator panel used</td>
<td>13</td>
</tr>
<tr>
<td>2.4.3</td>
<td>Installed software</td>
<td>13</td>
</tr>
<tr>
<td>3</td>
<td>Installation Requirements</td>
<td>14</td>
</tr>
<tr>
<td>4</td>
<td>Migration of a STEP 7 V5.5 and HMI Project → WinCC (TIA Portal)</td>
<td>17</td>
</tr>
<tr>
<td>4.1</td>
<td>WinCC flexible project integrated in STEP 7</td>
<td>17</td>
</tr>
<tr>
<td>4.2</td>
<td>Migrating from S7-300/400 to S7-1200/1500 controllers</td>
<td>17</td>
</tr>
<tr>
<td>5</td>
<td>Migration of a WinCC flexible Project → WinCC (TIA Portal)</td>
<td>18</td>
</tr>
<tr>
<td>5.1</td>
<td>Graphical overview</td>
<td>18</td>
</tr>
<tr>
<td>5.2</td>
<td>Migration examples</td>
<td>20</td>
</tr>
<tr>
<td>5.2.1</td>
<td>Case 1: WinCC flexible Runtime configuration</td>
<td>20</td>
</tr>
<tr>
<td>5.2.2</td>
<td>Case 2: Panel configuration &quot;WinCC flexible 2008 SP3&quot;</td>
<td>20</td>
</tr>
<tr>
<td>5.2.3</td>
<td>Case 3: Panel configuration &quot;WinCC flexible 2008 SP5&quot;</td>
<td>21</td>
</tr>
<tr>
<td>6</td>
<td>Upgrading WinCC (TIA Portal) Vx → WinCC (TIA Portal) Vy</td>
<td>23</td>
</tr>
<tr>
<td>6.1</td>
<td>Graphical overview</td>
<td>23</td>
</tr>
<tr>
<td>6.2</td>
<td>Instruction</td>
<td>23</td>
</tr>
<tr>
<td>7</td>
<td>Licensing</td>
<td>24</td>
</tr>
<tr>
<td>7.1</td>
<td>Licensing older versions</td>
<td>24</td>
</tr>
<tr>
<td>7.2</td>
<td>Upgrading licenses</td>
<td>24</td>
</tr>
<tr>
<td>8</td>
<td>Post-processing</td>
<td>25</td>
</tr>
<tr>
<td>9</td>
<td>Migration Messages</td>
<td>25</td>
</tr>
<tr>
<td>9.1.1</td>
<td>Unspecified CPU</td>
<td>26</td>
</tr>
<tr>
<td>9.1.2</td>
<td>Operator panel is empty and will not be migrated</td>
<td>26</td>
</tr>
<tr>
<td>9.1.3</td>
<td>Required GSD file missing</td>
<td>27</td>
</tr>
<tr>
<td>9.1.4</td>
<td>No suitable version of STEP 7 installed</td>
<td>28</td>
</tr>
<tr>
<td>10</td>
<td>Glossary</td>
<td>28</td>
</tr>
<tr>
<td>11</td>
<td>Appendix</td>
<td>30</td>
</tr>
<tr>
<td>11.1</td>
<td>Service and Support</td>
<td>30</td>
</tr>
<tr>
<td>11.2</td>
<td>Links and literature</td>
<td>31</td>
</tr>
<tr>
<td>Section</td>
<td>Title</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>11.3</td>
<td>Change documentation</td>
<td>31</td>
</tr>
</tbody>
</table>
1 Task

1.1 Introduction

Due to the ongoing development in automation technology, the engineering software used also continues to evolve.

At some point, existing projects have to be converted to the new engineering software or parts of an "old" engineering software have to be migrated to the new engineering software.

The TIA portal is the user interface that contains the engineering software such as STEP 7 or the HMI software.

The following figure illustrates the task.

A PLC control program created with the STEP 7 V5.5 Manager with integrated HMI operator panel is to be migrated to WinCC (TIA Portal). Various points must be observed in advance.

Figure 1-1

The application example essentially shows the prerequisites that are necessary for the upgrade/migration of an HMI operator panel.

Where necessary, reference is made to further links.
This migration guide helps

- migration from
  - WinCC flexible to WinCC (TIA Portal)

- or upgrading
  - WinCC (TIA Portal) Vx to WinCC (TIA Portal) Vy

Depending on the software version you are using, the steps required to migrate or upgrade to the current WinCC (TIA Portal) version are described.

Examples

- You are currently using SIMATIC STEP 7 V5.x and WinCC flexible 2008 to create automation programs. You would now like to change to TIA Portal V15.1, e.g. to use the functions of the Comfort Panels. The migration guide describes the necessary steps and prerequisites.

- In order to create automation programs, use WinCC (TIA Portal) V12 and you want to upgrade to the TIA Portal V15.1. The migration guide describes the necessary steps and prerequisites for upgrading the software.
### 1.2 Overview of the initial situation

The different initial situations are described below. The corresponding link will take you directly to the solution.

Figure 1-2

<table>
<thead>
<tr>
<th>Initial situation</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Basics</strong></td>
<td></td>
</tr>
<tr>
<td>Migration of STEP 7 V5.x and WinCC flexible 2008 to TIA Portal</td>
<td></td>
</tr>
<tr>
<td>• Full migration</td>
<td></td>
</tr>
<tr>
<td>o You have a configuration that was created with STEP 7 V5.x and WinCC flexible 2008.</td>
<td>Link</td>
</tr>
<tr>
<td>o Further processing is now to be carried out with the TIA Portal.</td>
<td></td>
</tr>
<tr>
<td>• Partial migration</td>
<td></td>
</tr>
<tr>
<td>o You have a configuration that was created with STEP 7 V5.x and WinCC flexible 2008.</td>
<td>Link</td>
</tr>
<tr>
<td>o STEP 7 V5.x should still be processed with the SIMATIC manager.</td>
<td></td>
</tr>
<tr>
<td>o The HMI project is to be executed with WinCC (TIA Portal).</td>
<td></td>
</tr>
<tr>
<td>Upgrading from WinCC (TIA Portal) Vx to WinCC (TIA Portal) Vy</td>
<td></td>
</tr>
<tr>
<td>You have created a project with WinCC (TIA Portal) V12 and want to upgrade the project to the current WinCC (TIA Portal).</td>
<td>Link</td>
</tr>
</tbody>
</table>
2 Basics

2.1 Information on the products

For information about the SIMATIC hardware and software components, visit the Siemens "Industry Online Support" pages.

- Access the Industry Online Support page using the following link https://support.industry.siemens.com
- Enter the search term or the article number in the search field and confirm the entry by pressing the "Enter" button (1).

For detailed information about working with Online Support, visit the "Industry Online Support" home page (2).

Figure 2-1

2.1.1 Software compatibility

Before migrating to TIA Portal, check the compatibility of the installed software and the operating system. To do this, use the "Compatibility Tool".

You will find the tool on the Siemens http://www.siemens.com/kompatool

2.1.2 Software and operating system requirements

For information about the engineering software, refer to the delivery releases of the product you are using.
For information about the hardware and operating system requirements, refer to the compatibility tool.

2.2 WinCC (TIA Portal)

2.2.1 HMI software overview

Comparison of the successor software

<table>
<thead>
<tr>
<th>No.</th>
<th>WinCC flexible / WinCC Vx</th>
<th>WinCC (TIA Portal)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>WinCC flexible Micro</td>
<td>--</td>
</tr>
<tr>
<td>2.</td>
<td>WinCC flexible Compact</td>
<td>WinCC Basic</td>
</tr>
<tr>
<td>3.</td>
<td>WinCC flexible Standard</td>
<td>WinCC Comfort</td>
</tr>
<tr>
<td>4.</td>
<td>WinCC flexible Advanced</td>
<td>WinCC Advanced</td>
</tr>
<tr>
<td>5.</td>
<td>WinCC V7.x</td>
<td>WinCC Professional</td>
</tr>
</tbody>
</table>

Engineering Software WinCC (TIA Portal)

WinCC (TIA Portal) is offered in different editions.
- WinCC Basic
- WinCC Comfort
- WinCC Advanced
- WinCC Professional

Depending on the edition selected, different HMI operator panels can be configured. A “higher” edition always includes the HMI operator panels of the “lower” edition.

With the “WinCC Comfort” software, for example, you can configure all HMI operator panels listed in “WinCC Basic” and “WinCC Comfort”.

The following figure shows an overview of the engineering software and the possible target systems.

Figure 2-2
Remarks
When installing, for example, the “WinCC Basic” engineering software, the components for “WinCC Comfort” and “WinCC Advanced” will also be installed. The scope of services of the engineering software will be enabled by the license used. Therefore, you can also adapt the functional range later on to your requirements by upgrading your existing license. There is no need to reinstall the software.

2.2.2 STEP 7 Software overview

Comparison of the successor version
Table 2-2

<table>
<thead>
<tr>
<th>No.</th>
<th>STEP 7 V5.x</th>
<th>STEP 7 V15</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>STEP 7 Micro / Win</td>
<td>--</td>
</tr>
<tr>
<td>2.</td>
<td>--</td>
<td>STEP 7 Basic</td>
</tr>
<tr>
<td>3.</td>
<td>STEP 7 Professional 2010</td>
<td>STEP 7 Professional V15</td>
</tr>
</tbody>
</table>

Engineering software STEP 7
STEP 7 V15 is available in different editions and options. Depending on the selected edition or option, different controllers can be configured.
The following figure shows an overview of the engineering software and the possible target systems.
Figure 2-3
2 Basics

2.3 Migration requirements

2.3.1 Checking the hardware and software components used

STEP 7/HMI hardware used

Use the compatibility tool to perform this check.
You will find the tool on the Siemens "Industry Online Support" pages.
http://www.siemens.com/kompatool (en)

2.3.2 WinCC flexible project

General information

WinCC (TIA Portal) V15 no longer supports the HMI operator panels that used to be configurable in WinCC flexible 2008 SP3 / SP5.
For this reason, a WinCC flexible 2008 SP3 /SP5 configuration cannot be directly migrated to WinCC (TIA Portal) V15. For more detailed information, refer to chapter 2.3.3, "Non-supported operator panels under "WinCC V15."

- Projects created with WinCC flexible 2008 SP2 and higher can be migrated to WinCC V14.
  Projects that have been created with a version prior to 2008 SP2 will first have to be opened and saved with WinCC flexible 2008 SP2 or higher.
- Prior to migration, generate the WinCC flexible configuration.
  Make sure any errors or warning messages in the project are fixed.
- Before the migration, check that the HMI operator panel used is supported by WinCC (TIA Portal). If this is not the case, the HMI operator panel will be automatically replaced by the successor device during the migration. For more information, see the next chapter.

Stand-alone project

If the WinCC flexible project is not integrated in STEP 7, WinCC flexible does not have to be installed on the configuration computer in order to migrate the project to WinCC V14.

Selecting new panels

For the migration of the successor devices, for example, the following points have to be considered.

- Installation cutout/installation dimensions
- Interfaces
- Function key assignment
- Screen format conversion
2 Basics

Overview of successor devices

Table 2-3

<table>
<thead>
<tr>
<th>WinCC flexible</th>
<th>Successor</th>
<th>WinCC (TIA Portal)</th>
</tr>
</thead>
<tbody>
<tr>
<td>TD (100-400c); OP 73micro; TP 177micro; OP 73; OP 77A; TP 177A</td>
<td>→</td>
<td>Basic Panel</td>
</tr>
<tr>
<td>OP 77B; OP 177B; OP 277; TP 177B; TP 277; MP 177; MP 277; MP 377</td>
<td>→</td>
<td>Comfort Panel</td>
</tr>
<tr>
<td>PC Runtime</td>
<td>→</td>
<td>Runtime Advanced</td>
</tr>
</tbody>
</table>

For more detailed information on basic or comfort panels, please refer to the “Migration Guide” manual and a tabular comparison of the "old" panels and their successor devices.

- Manual: Basic Panels Migration Guide

2.3.3 Non-supported operator panels under "WinCC V15"

The following table lists all HMI operator panels that are no longer supported after the version change to WinCC (TIA Portal) V15.

Table 2-4

<table>
<thead>
<tr>
<th>70 series</th>
<th>170 series</th>
<th>270 series</th>
<th>Multi Panel</th>
</tr>
</thead>
<tbody>
<tr>
<td>OP 73</td>
<td>TP 177A</td>
<td>TP 277 6&quot;</td>
<td>MP 177 6&quot; Touch</td>
</tr>
<tr>
<td>OP 77A</td>
<td>TP 177A Portrait</td>
<td>OP 277 6&quot;</td>
<td>MP 277 8&quot; Key</td>
</tr>
<tr>
<td>OP 77B</td>
<td>TP 177B 4&quot; PN/DP</td>
<td>MP 277 8&quot; Touch</td>
<td></td>
</tr>
<tr>
<td>OP 77B</td>
<td>TP 177B 6&quot; mono DP</td>
<td>MP 277 10&quot; Key</td>
<td></td>
</tr>
<tr>
<td>OP 177B</td>
<td>TP 177B 6&quot; PN/DP</td>
<td>MP 277 10&quot; Touch</td>
<td></td>
</tr>
<tr>
<td>OP 177B</td>
<td>OP 177B 6&quot; mono DP</td>
<td>MP 377 12&quot; Key</td>
<td></td>
</tr>
<tr>
<td>OP 177B</td>
<td>OP 177B 6&quot; PN/DP</td>
<td>MP 377 12&quot; Touch</td>
<td></td>
</tr>
<tr>
<td>OP 177B</td>
<td>OP 177B 6&quot; PN/DP</td>
<td>MP 377 15&quot; Touch</td>
<td></td>
</tr>
<tr>
<td>OP 177B</td>
<td>OP 177B 6&quot; PN/DP</td>
<td>MP 377 15&quot; Touch daylight</td>
<td></td>
</tr>
<tr>
<td>OP 177B</td>
<td>OP 177B 6&quot; PN/DP</td>
<td>MP 377 19&quot; Touch</td>
<td></td>
</tr>
</tbody>
</table>

2.3.4 STEP 7 V5.x project

Projects created with STEP 7 V5.4+SP5 and higher can be migrated to STEP 7 V15.

For detailed information, please refer to entry ID 62100731 62100731 "What are the requirements for migrating a STEP 7 V5.x project to STEP 7 Professional (TIA Portal)?"
2 Basics

2.4 Hardware/software is not supported

2.4.1 PLC modules used

If the PLC module used is not supported by TIA Portal or if the existing PLC hardware cannot be easily replaced, you can alternatively migrate, for example, only the HMI project to WinCC (TIA Portal) and continue to use STEP 7 V5.x for the existing "STEP 7 part". For information about combined configuration with WinCC (TIA Portal) and STEP 7 V5.x, please refer to entry ID 73502293.

2.4.2 Operator panel used

If the operator panel you are using is not supported by TIA Portal, the operator panel will be automatically modified to an appropriate successor device during the migration. Information on the successor devices can be found in chapter 2.3.2 "WinCC flexible project".

2.4.3 Installed software

For the TIA software to run correctly, the specified requirements regarding the
- operating system used and the
- STEP 7 / HMI software used
must be met. Further information can be found in Chapter 2, "Basics".
3 Installation Requirements

This chapter describes which software must be installed on the configuration PC in order to migrate an existing STEP 7 V5.x or WinCC flexible 2008 SP3 configuration to WinCC (TIA Portal) V15 and higher.

**Note**
You can install several versions of WinCC (TIA Portal) on one configuration PC. It is a good idea to always have the current WinCC (TIA Portal) installed on the configuration PC.

**Example 1**
The following software is installed on the configuration computer.
- STEP 7 V5.x and WinCC flexible 2008 SP3 or WinCC flexible 2008 SP5.
- STEP 7 V14 and WinCC V14
In this case all prerequisites for migration are given.

**Example 2**
A WinCC flexible project (stand alone) is to be migrated.

**Solution:**
In this case, WinCC (TIA Portal) must be installed on the PC. The version (Basic, Comfort or Advanced) depends on the HMI operator panel in the WinCC flexible configuration.

For detailed information, please refer to Chapter 2.3.2 "WinCC flexible project".

**Summary**
Table 3-1

<table>
<thead>
<tr>
<th>Source project</th>
<th>Migration</th>
<th>Configuration computer</th>
</tr>
</thead>
<tbody>
<tr>
<td>WinCC flexible 2008 SP3 / SP5 project</td>
<td>→</td>
<td>WinCC Basic/Comfort/Advanced (depending on the operator panel used)</td>
</tr>
</tbody>
</table>
**Example 3**

A STEP 7 V5.x project is to be migrated.

**Solution:**

In this case STEP 7 V5.x and STEP 7 V14 must be installed on the PC.

For details about the STEP 7 requirements, refer to Entry ID **62100731**.

Alternatively to the STEP 7 V5.x installation, you can convert the source project into the migratable "*.ap14" file format, using the "Migration Tool". This file can be imported by the TIA Portal.

**Note**

The migration tool is available on the installation DVD in the "Support → Migration_Tool_TIA_V14.exe" folder and will be installed on the PC where STEP 7 V5.x is installed. Alternatively see \13\.

**Summary**

Table 3-2

<table>
<thead>
<tr>
<th>Source project</th>
<th>Migration</th>
<th>Configuration computer</th>
</tr>
</thead>
<tbody>
<tr>
<td>• STEP 7 V5.x project</td>
<td>→</td>
<td>• STEP 7 V5.x</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• STEP 7 V14</td>
</tr>
<tr>
<td>• STEP 7 V5.x project</td>
<td></td>
<td>• STEP 7 V14</td>
</tr>
<tr>
<td>• Migration tool</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Converting the &quot;*.ap14&quot; file format</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Example 4**

You have a STEP 7 V5.x configuration with an integrated WinCC flexible 2008 SP3 project that is to be migrated.

**Solution:**

In this case, STEP 7 V5.x, WinCC flexible, STEP 7 V14 and WinCC V14 must be installed on the PC.

Alternatively to the STEP 7 V5.x and WinCC flexible installation, you can use the migration tool to convert the source project to the migration-capable "*.ap14" file format. This file can be imported by the TIA Portal.

**Note**

The migration tool is available on the installation DVD in the "Support → Migration_Tool_TIA_V14.exe" folder (alternatively see \13\) and will be installed on the PC where STEP 7 V5.x and WinCC flexible 2008 SP3 are installed.
3 Installation Requirements

Summary

Table 3-3

<table>
<thead>
<tr>
<th>Source project</th>
<th>Migration</th>
<th>Configuration computer</th>
</tr>
</thead>
<tbody>
<tr>
<td>• STEP 7 V5.x project with integrated WinCC flexible 2008 SP3/SP5 configuration</td>
<td></td>
<td>• STEP 7 V5.x&lt;br&gt;• WinCC flexible 2008 SP3 / SP5&lt;br&gt;• STEP 7 V14&lt;br&gt;• WinCC Basic/Comfort/Advanced (depending on the operator panel used)</td>
</tr>
<tr>
<td>• STEP 7 V5.x project with integrated WinCC flexible 2008 SP3/SP5 configuration</td>
<td></td>
<td>• STEP 7 V14&lt;br&gt;• WinCC Basic/Comfort/Advanced (depending on the operator panel used)</td>
</tr>
<tr>
<td>• Migration tool Converting the &quot;*.ap14&quot; file format</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Example 5

A ProTool project is to be migrated.

Solution:
In order to migrate projects from ProTool to TIA Portal, it is mandatory to go through WinCC flexible 2008 SP3/SP5.
4 Migration of a STEP 7 V5.5 and HMI Project → WinCC (TIA Portal)

4.1 WinCC flexible project integrated in STEP 7

If WinCC flexible configuration is integrated in STEP 7, the following software must be installed on the configuration computer to migrate the project to WinCC V15.

- WinCC V14
- STEP 7 V5.x and
- WinCC flexible 2008 SP3 / SP5.

Alternatively, first copy the WinCC flexible project from the STEP 7 configuration → "stand alone project" (see chapter 5, "Migration of a WinCC flexible Project → WinCC (TIA Portal)").

In entry ID 54695062 you will find an instruction how to migrate a WinCC flexible project integrated in STEP 7 to WinCC (TIA Portal).

A STEP 7 project with a SIMATIC S7-300 and an MP 277 Touch Panel is used as a project template.

4.2 Migrating from S7-300/400 to S7-1200/1500 controllers

Depending on the STEP 7 commands used or special blocks, it may be necessary to make adjustments after migration.

For the migration, we recommend not to implement the S7-300/400 programs without any changes.

The command records and command structures between S7-300/400 and S7-1200/1500 differ. Commands in an S7-300 may be handled or processed differently. As a consequence, for example, access to a bit range that used to be absolute may have to be customized for symbolic addressing. For detailed information on this topic, see chapter 31.11.2 "Links and literature" in \[11\].

Below the procedure for a partial migration of a STEP 7 V5.x incl. WinCC flexible 2008 project to WinCC (TIA Portal) is described.
5 Migration of a WinCC flexible Project → WinCC (TIA Portal)

5.1 Graphical overview

The following figures show an overview of the intermediate steps necessary to migrate the configuration from the initial situation to WinCC (TIA Portal) V15 or higher.

Note

Using the WinCC (TIA Portal) V15 version, some HMI operator panels that were previously configurable in WinCC flexible 2008 SP3 / SP5 are no longer supported (see chapter 2.3.3, "Non-supported operator panels under "WinCC V15.").

For this reason, you cannot easily migrate, e.g. a WinCC flexible 2008 SP3/SP5 configuration directly to WinCC (TIA Portal) V15. Exceptions to this are the PC Runtime systems.

PC Runtime configuration

Figure 5-1

Initial situation – software used

WinCC flexible 2008 SP3 / SP5
PC Runtime project

No intermediate step required

WinCC (TIA Portal) V15 / V15.1
PC Runtime project
Panel configuration

Figure 5-2

Initial situation – software used

WinCC flexible 2008 SP3

Opening with...
WinCC (TIA Portal) V13 SP1 / SP2
or with...
WinCC (TIA Portal) V14 SP1

Intermediate step

WinCC flexible 2008 SP5

Opening with...
WinCC (TIA Portal) V14 SP1
as of update 2

Intermediate step

1. Device exchange to V15-
compliant operator panels
2. Saving the configuration

Opening with...
WinCC (TIA Portal) V15 / V15.1

Intermediate step

Opening with...
WinCC (TIA Portal) V13 SP2

1. "Migration Tool"
2. WinCC (TIA Portal) V13 SP2
5.2 Migration examples

The following examples illustrate the procedure for migrating a STEP 7 V5.x and WinCC flexible 2008 project to WinCC (TIA Portal).

Note
Before you start migrating projects, create a backup of the source project.

Figure 5-3

5.2.1 Case 1: WinCC flexible Runtime configuration

Starting point: You have a WinCC flexible Runtime configuration.

Solution:
Start WinCC (TIA Portal) V15 and run the "Migrate project" function. No other settings are required.

5.2.2 Case 2: Panel configuration "WinCC flexible 2008 SP3"

Starting point: You have an MP 277 Touch configuration that was created with WinCC flexible 2008 SP3.
5 Migration of a WinCC flexible Project → WinCC (TIA Portal)

Solution 1:
1. Start WinCC flexible 2008 SP3 and open the MP 277 Touch configuration.
2. Run the "Change device type…" function. Select the "WinCC flexible Runtime" device type and save the configuration.
4. Run the "Change device" function. In "New device", select a "TP1200 Comfort" panel. No other settings are required.

Solution 2:
1. Migrate the MP 277 Touch configuration to
   - WinCC (TIA Portal) V13 SP1 / SP2 or
   - WinCC (TIA Portal) V14 SP1.
2. In WinCC (TIA Portal), change a device. To do this, select the successor device. In this case: a Comfort Panel. Notes on the successor devices can be found in chapter 2.3.2 "WinCC flexible project" section "Overview of successor devices".
3. Save the changes and close the WinCC (TIA Portal) configuration.
4. Use WinCC (TIA Portal) V15 to open the new file. No other settings are required.

5.2.3 Case 3: Panel configuration "WinCC flexible 2008 SP5"

Starting point: You have an MP 277 Touch configuration that was created with WinCC flexible 2008 SP5.

Solution 1:
1. Use the migration tool.
   For information about the "migration tool" see Chapter 11.2 "Links and literature" in [13].
2. Use WinCC (TIA Portal) V13 SP2 to open the migration file.
3. In WinCC (TIA Portal), change a device. To do this, select the successor device. In this case: a Comfort Panel. Notes on the successor devices can be found in chapter 2.3.2 "WinCC flexible project" section "Overview of successor devices".
4. Save the changes and close the WinCC (TIA Portal) configuration.
5. Use WinCC (TIA Portal) V15 to open the new file. No other settings are required.

Solution 2:
1. Migrate the MP 277 Touch configuration to WinCC (TIA Portal) V14 SP1 Update 2 or higher.
2. In WinCC (TIA Portal), change a device. To do this, select the successor
device. In this case: a Comfort Panel. Notes on the successor devices can be
found in chapter 2.3.2 "WinCC flexible project" section "Overview of successor
devices".

3. Save the changes and close the WinCC (TIA Portal) configuration.

4. Use WinCC (TIA Portal) V15 to open the new file. No other settings are
required.
6 Upgrading WinCC (TIA Portal) Vx → WinCC (TIA Portal) Vy

6.1 Graphical overview

The following figure shows an overview of the intermediate steps required to migrate the configuration from the initial situation to WinCC (TIA Portal) V15 or higher.

Figure 6-1

Initial situation – software used

WinCC (TIA Portal) V13 SP1 / SP2
WinCC (TIA Portal) V14 SP1

No intermediate step required

WinCC (TIA Portal) V15 / V15.1

6.2 Instruction

The following example describes the procedure for upgrading a WinCC (TIA Portal) Vx to WinCC (TIA Portal) Vy.

Figure 6-2
Starting point: You have an MP 277 Touch configuration that was created with WinCC (TIA Portal) V13 SP1 / SP2 or WinCC (TIA Portal) V14 SP1.

Solution:

1. In the existing configuration, change a device. To do this, select the successor device. In this case: a Comfort Panel. Notes on the successor devices can be found in chapter 2.3.2 "WinCC flexible project" section "Overview of successor devices".
2. Save the changes and close the WinCC (TIA Portal) configuration.
3. Use WinCC (TIA Portal) V15 to open the new file. No other settings are required.

7 Licensing

7.1 Licensing older versions

The purchase of WinCC (TIA Portal) V15 provides you with a license that is also valid for WinCC (TIA Portal) V13 and WinCC (TIA Portal) V14.

7.2 Upgrading licenses

When you have migrated the STEP 7 V5.x / WinCC flexible project to TIA Portal, you may have to upgrade the existing STEP 7 V5.x / WinCC flexible licenses to WinCC (TIA Portal).

For detailed information about the required licenses and their order numbers, refer to the delivery release of the product used.

**NOTICE**

When you upgrade the licenses to WinCC (TIA Portal), you will no longer have a license for the STEP 7 V5.x / WinCC flexible 2008 SP3/SP5 software.

For detailed information about upgrading licenses, refer to the following Entry IDs.

- HMI software

- STEP 7 software
8 Post-processing

Customizing controller

If the existing controller was replaced by an “unspecified CPU”, open the device configuration of the PLC controller.

Select a CPU from the hardware catalog. Replace the unspecified CPU by the CPU from the hardware catalog.

Make the required settings such as "connect interface", etc.

Adapting HMI operator panel

Check the device configuration after migration and adapt if necessary.

Adapting screens

If you changed operator panels, you will have made settings in the "Options > Visualization > Resize screen" menu before the change.

In the individual screens, check whether the adaptations made are as you expect them to be.

Combined configuration with WinCC (TIA Portal) and STEP 7 V5.x

In some cases, due to technical or customer-specific reasons, it is necessary to continue creating the PLC program with the "STEP 7 V5.x" software and the HMI configuration with the "WinCC (TIA Portal)" software.

Entry ID 73502293 provides solutions for the combined use of WinCC (TIA Portal) and STEP 7 V5.x.

9 Migration Messages

Migration log

A migration log is created for each migration. The log contains the following information:

- Migrated objects
- Changes to objects made during migration
- Errors that occurred during migration
- If required, a link via which you can receive more information.
- Some messages have a question mark next to them. Clicking the question mark provides you with more information about the message.

In the project tree, select "Common data > Logs" to view the log.
Migration was canceled

If the migration failed, an XML file is created as a log in the project directory in the "Logs" folder. You can open this file with any XML editor (e.g., Notepad) to find out why the migration failed.

9.1.1 Unspecified CPU

If the existing CPU was replaced by an unspecified CPU, the reason for this may be that you did not check the "Include hardware configuration" check box or that the hardware configuration is not supported by TIA Portal.

The first step after migrating without hardware configuration is to change the unspecified CPU to a specified CPU.

Unspecified CPUs are placeholders for certain CPUs from the hardware catalog that are currently not yet known.

The project is not fully functional until the unspecified CPU is specified.

9.1.2 Operator panel is empty and will not be migrated

If this message is output, it is possible that the "Include hardware configuration" check box is unchecked.
Normally, you only have to change the connection to the CPU in the device configuration.

9.1.3 Required GSD file missing

This message appears if the GSD file you used to configure the slave in SIMATIC STEP 7 is not installed in TIA Portal.

Correction

Even though the migration was not executed, a project folder was created for the new project. The "AdditionalFiles\GSD" directory is located in this project folder. All GSD files required for migration in the TIA Portal are included in this directory. Please install these GSD files into the TIA Portal.

Brief description

1. In the TIA Portal, select the "Options > Install device description file (GSD)" menu.
2. In the "Install general station description file" dialog, select the directory that contains the GSD files. By default, this is the "...AdditionalFiles\GSD" subfolder in the project folder of the migrated project.
3. Select the GSD files from the list.
4. Click the "Install" button.

After installing the missing GSD files, repeat the project migration.

Notes

- Current GSD files can be downloaded from the Siemens "Industry Online Support" pages.
- GSD (GSE) files stored on the PC are listed in the STEP 7 installation directory.
  Example: C:\Program Files\Siemens\Step7\S7DATA\GSD

You will find the associated "Bitmap" in the "NSBMP" folder.
Example: C:\Program Files\Siemens\Step7\S7DATA\NSBMP
9.1.4 No suitable version of STEP 7 installed

If you receive this message, you do not have STEP 7 or the suitable version of STEP 7 installed on your PC.

If you do not want to install STEP 7 on the PC, you can use the migration tool to resolve the issue. Information on this can be found in the chapter 2, "Basics".

10 Glossary

Note
When this migration guide uses the term "TIA Portal", this includes the "WinCC V15" and "STEP 7 V15" engineering tools:

TIA Portal

The "TIA Portal" is an integrated engineering framework for controllers, HMI and drives.

This engineering framework is used to run, for example,
- the SIMATIC WinCC V15 software, an engineering tool for all HMI operator panels.
- the SIMATIC STEP 7 V15 software, an engineering tool for all SIMATIC controllers.

The engineering framework is installed automatically during installation, for example, when installing WinCC Comfort.

WinCC (TIA Portal) editions

WinCC V14 / V15 / V15.1 Basic
For configuring SIMATIC HMI Basic Panels.
WinCC Basic is part of the STEP 7 Basic and Professional program packages and is not upgradable.

WinCC V14 Comfort
For configuring the SIMATIC HMI Comfort Panels as well as Mobile Panels, Panels of the x70 series, and Multi Panels.

WinCC V15 / V15.1 Comfort
For configuring SIMATIC HMI Comfort Panels and Mobile Panels.

WinCC V14 / V15 / V15.1 Advanced
For configuring PC-based HMI single-workstation solutions.

WinCC V14 / V15 / V15.1 Professional
For process visualization and SCADA functionalities.
**STEP 7 V15**
SIMATIC STEP 7 in the TIA Portal is the software for configuring, programming, reviewing, and diagnosing all SIMATIC controllers. It is divided into "STEP 7 Basic V15" and "STEP 7 Professional V15".

- **STEP 7 Basic V15**
  SIMATIC STEP 7 Basic V15 is a cost-efficient subset of the STEP 7 Professional controller software in the TIA Portal which can be used both for the engineering of the SIMATIC S7-1200 Micro controllers and the configuration of the SIMATIC HMI Basic Panels, since WinCC Basic is part of the software package.

- **STEP 7 Professional V15**
  STEP 7 Professional is the engineering tool for configuring and programming all SIMATIC controllers. Here, as well, SIMATIC WinCC Basic is included for basic visualization tasks.
11 Appendix

11.1 Service and Support

Industry Online Support

Do you have any questions or need support?
Siemens Industry Online Support offers access to our entire service and support know-how as well as to our services.
Siemens Industry Online Support is the central address for information on our products, solutions and services.
Product information, manuals, downloads, FAQs and application examples – all information is accessible with just a few mouse clicks at:
https://support.industry.siemens.com

Technical Support

Siemens Industry’s Technical Support offers quick and competent support regarding all technical queries with numerous tailor-made offers – from basic support right up to individual support contracts.
Please address your requests to the Technical Support via the web form:
https://www.siemens.en/industry/supportrequest

SITRAIN – Training for Industry

With our globally available training courses for our products and solutions and using innovative teaching methods, we help you achieve your goals.
More information on the training courses offered as well as on locations and dates is available at:
https://www.siemens.en/sitrain

Service offer

Our service offer includes the following:
- Plant Data Services
- Spare Parts Services
- Repair Services
- On Site and Maintenance Services
- Retrofit and Modernization Services
- Service Programs and Agreements
Detailed information on our service offer is available in the Service Catalog:
https://support.industry.siemens.com/cs/sc

Industry Online Support app

Thanks to the “Siemens Industry Online Support” app, you will get optimum support even when you are on the move. The app is available for Apple iOS, Android and Windows Phone:
https://support.industry.siemens.com/cs/ww/en/sc/2067
11.2 Links and literature

Table 11-1

<table>
<thead>
<tr>
<th>Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1\</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>2\</td>
</tr>
<tr>
<td>3\</td>
</tr>
<tr>
<td>4\</td>
</tr>
<tr>
<td>5\</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>6\</td>
</tr>
<tr>
<td>7\</td>
</tr>
<tr>
<td>8\</td>
</tr>
<tr>
<td>9\</td>
</tr>
<tr>
<td>10\</td>
</tr>
<tr>
<td>11\</td>
</tr>
<tr>
<td>12\</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>13\</td>
</tr>
</tbody>
</table>

11.3 Change documentation

Table 11-2

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Modification</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1.0</td>
<td>09/2013</td>
<td>First version</td>
</tr>
<tr>
<td>V2.0</td>
<td>05/2017</td>
<td>Content edited and customized to V14 SP1</td>
</tr>
<tr>
<td>V2.1</td>
<td>02/2018</td>
<td>Content customized to V15.</td>
</tr>
<tr>
<td>V3.0</td>
<td>02/2019</td>
<td>Complete revision and structuring</td>
</tr>
</tbody>
</table>